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TOP 10 MISTAKES MY CLIENTS MAKE AND HOW TO FIX 

THEM 

We all have clients who are using QuickBooks but are they all using it correctly?  Many of these 
clients have learned to use the software by trial and error.  Clients think that since a check looks 
like a check and an invoice looks like an invoice; they too can be a bookkeeper.  Without 
accounting training and the time spent on looking at many of the different reports, quite often they 
believe everything is fine.  By going through the following 10 issues, and the related “fixes” you 
will be better equipped to quickly and easily identify the most common errors and understand the 
alternatives to effectively and efficiently correct the situation.   

Although it is never fun to tell a client they have been entering information incorrectly, this reality 
does provide you a great opportunity to develop a closer relationship with the client as their 
QuickBooks expert and to train them how to use the software to provide better business 
information for compliance and decision making purposes. 

OBJECTIVES 
• Determine if your client has done these 10 things wrong 

• Obtain a basic understanding of the alternatives available to fix these errors 

• Learn methods of working efficiently with QuickBooks client’s data files 

• Explore the symptoms and causes of these common mistakes 

• Discover the solutions to eliminate the errors in the future 
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NOTES ABOUT APPROACH 

Because various users choose to use the navigators, or not, and may customize the icon bar, our 
instructions will use the menu bar at the top of the software. QUICKBOOKS: PREMIER 2008: 
ACCOUNTANT EDITION is the version of the software we will be using.  While many of the fixes 
will work with other versions, this is the most comprehensive and feature rich product that 
includes reports and functionality accountants want and need.  We are using the sample data file 
included with the software to make it easy for you to test the solutions with your own copy of the 
software back in your office. 

 

 

 

Also, the majority of these fixes require that you have access to the live data file.  Many solutions 
cannot be implemented when using the Accountant’s Review Copy of the data.  There are many 
ways to access the live data including working at the client’s office, obtaining a back up of the 
data to use in your office (don’t forget to remind the client not to enter any transactions while you 
have it or your back up will overwrite their information), utilize the Accountant’s Copy or use 
QuickBooks: Premier 2008: Accountant Edition feature of Remote Access.  While we cannot get 
into the details on all of these methods here, there is a free recorded webcast on remote access 
that you may find valuable at 
http://accountant.intuit.com/training_cpe/archived_webcasts.aspx#section1 
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BONUS NOTES 

One thing you can never do enough is back up the data.  Do not overwrite the previous backups.  
Back up before you start and at every major step along the way.  In most cases you will not need 
to restore the back up, but if you do, being able to restore the data to a specific point in time is 
critical.  Backing up to the client’s hard drive is OK (but make sure you know where you have 
saved the files), but it is recommended that you burn a CD or copy the backup files to a USB 
drive so you can take them with you.  What has worked well for me is to back it up using today’s 
date then add a letter to subsequent backups, as the naming convention for the back-up file.   

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: File > Save Copy or Backup 
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Within QuickBooks there is no undo, undelete, or any other way to say “Oops, I didn’t mean to do 
that.”  For this reason, in addition to the back ups, it is recommended that you print any 
information you may need.  This may be a report, it may be the journal entry associated with a 
transaction, etc.  When you print the report, don’t forget to print the report to one page wide, 
landscape may increase the font size slightly, and to widen any columns that contain critical data 
that may be cut off by moving the diamond to the right at the top of the column. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Invoice > Journal > Print Report 

  
 

For major changes, those that will take considerable time, and the situations where information 
has been entered incorrectly, have the client sit with you while the changes are made serves 
three purposes: 

They see the results of the situation they have created which will hopefully help them to do better 
in the future. 

They understand the changes that have been made in the file which will often eliminate the 
subsequent calls about what you did or why things look different than before. 

They know firsthand the amount of time it took for you to correct the problem which will hopefully 
remove the “surprise factor” when they receive your request for payment. 
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CHART OF ACCOUNTS ERROR 

ERRORS & SYMPTOMS 
• Common Errors: 

o Duplicate accounts 

o Accounts duplicate the function of customers, vendors, or items 

• Primary Indication:  Extremely long chart of accounts list  

• Supplemental Symptom:  The presentation on the Balance Sheet and Profit & Loss 
reports looks wrong (i.e. accounts are set up with an incorrect type) 

One of the easiest places for most accountants to start is to deal with chart of accounts issues.  
Based on experience and training, it is usually quickly apparent if the chart of accounts is too 
long, if there are duplicates, or if the accounts have been set up as the wrong type.  The account 
type controls the presentation for financial reports.  In addition it is used for the highest level of 
subtotals.  

Looking over the chart of accounts list or creating the Balance Sheet and Profit & Loss reports will 
provide an indication of the extent of the issue. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Lists > Chart of Accounts 
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CHART OF ACCOUNTS FIXES 

EDIT ACCOUNT TYPE 
For the chart of accounts, the edit option permits a change of account name or a change of an 
account type (except changing to or from Accounts Receivable or Accounts Payable). This 
option, when used carefully, can correct data entry errors in total, rather than transaction-by-
transaction. Because this option does change the account in total, prior periods may be affected. 
Depending on the timing of the change, and the magnitude, it may be better to edit the individual 
transactions or do a journal entry to correctly reclassify the balance to a new account, and then 
use the check box option to make the old account inactive. For a new QuickBooks client, 
however, this can save countless hours and tedious corrections to correct the existing chart of 
accounts. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Lists > Chart of Accounts >  
Single click on the account to be changed > Edit > Edit Account 

 

MERGE ACCOUNTS 
A variation on the edit procedure is to edit the name to match another name on the same list. 
When the OK button is clicked, the software states: “This name is already being used. Would you 
like to merge them?” If you choose yes, all of the transactions using the name being edited will be 
merged into the changed name. Use this option carefully, since there is no easy way to undo a 
merge, except transaction-by-transaction. 

If accounts have been set up incorrectly, it is possible to edit or merge the information. To edit an 
account permits a change of account name or a change of an account type (except changing to 
or from Accounts Receivable or Accounts Payable). This option, when used carefully, can correct 
data entry errors in total, rather than transaction-by-transaction. Because this option does change 
the account in total, prior periods may be affected. Depending on the timing of the change, and 
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the magnitude, it may be better to edit the individual transactions or do a journal entry to correctly 
reclassify the balance, and then use the option to make the account inactive.  

A variation on the edit procedure is to edit the name to match another account of the same type. 
When the OK button is clicked, the software states: “This name is already being used. Would you 
like to merge them?” If you choose yes, all of the transactions in the account being edited will be 
merged into the account with the same name. Use this option carefully, since there is no easy 
way to undo a merge, except transaction-by-transaction. 

PATH: Lists > Chart of Accounts > Single click on the account to be merged > Edit > Edit Account > 
Change name or number > OK 

TIP: If the two accounts on the chart of accounts list to be merged are different account types, 
changing the name and the type cannot be done in one step.  First change the account type and then 
change the name to merge the accounts together. 

NOTE: Be very careful when merging.  The information will remain for the account that the name is 
being changed to, not the name that is being changed.  For example, if an account has been created 
that is called B of A Checking and the account number from the bank has been entered on the edit 
account screen, then a new account just called Checking has been created without the account 
number. If B of A Checking is merged into Checking, the remaining account will not have the 
account number. If Checking is merged into B of A Checking, the account number will remain. The 
same is true for the other lists. For example, a customer with the address is merged into a customer 
without the address; the previous information will be lost! 

TRICK: When the accounting preference for account numbers has been turned on, it is possible to 
merge accounts simply by having the same account number.  The name will not matter.  Again, just 
like in the previous example, the account name will remain for the account number that the changed 
account will be merged into. 

NOTE: When Balance Sheet accounts are merged, any cleared transactions are merged into the new 
account as uncleared. 

EDIT ACCOUNT DETAILS 
In addition to using the edit feature to change the account type and merge accounts together, the 
edit feature also controls sub-accounts and inactive status. 

Sub-accounts 
The advantage of sub-accounts is that the detail can be displayed on financial statement reports 
for management purposes.  But with the simple click of a button, the sub-accounts can be “rolled 
up” into the “main” account for summarized presentation. 

PATH: Lists > Chart of Accounts > Single click on the account to be changed > Edit > Edit Account > 
Mark checkbox for sub-account of > Choose account > OK 

TRICK: In addition to using the edit feature to make the account a sub-account, it is also possible to 
use the mouse to click on the diamond to the left of the account name, drag it below the “main” 
account and then drag it “under” the main account to have it remain as a sub-account. 
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QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Reports > Company & Financial >  
Profit & Loss Standard 

 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Reports > Company & Financial >  
Profit & Loss Standard > Collapse 
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INACTIVE ACCOUNTS 
Accounts with activity cannot be deleted since those transactions will have “nowhere to go.”  The 
most important advantage to making an account inactive is that an inactive account no longer 
appears on the pull down list when entering transactions.  The accounts will still appear on 
reports if they are needed. 

PATH: Lists > Chart of Accounts > Single click on the account to be changed > Edit > Edit Account > 
Mark checkbox for inactive > OK 

 

TIP: In addition to using the edit feature to make an account inactive, the inactive choice is available 
by right clicking with the mouse on the account.  Also, if all of the inactive accounts are displayed on 
the chart of accounts list, clicking in the “X” column is a quick and easy to make accounts inactive. 

NOTE: If a memorized transaction has been coded to an account that is subsequently marked as 
inactive, that transaction will continue to use the inactive account. 

16 



Top 10 QuickBooks Mistakes Clients Make 

ACCOUNTS PAYABLE ERROR 

ERROR & SYMPTOMS 
• Common error: Client enters bills, and then writes checks 

• Primary Indication: The AP Aging Reports shows many very old bills  

• Supplemental Symptoms:     

o Accounts Payable balance is very high 

o Expenses seem unreasonably high 

o The bank account balance looks right 

The quickest and easiest way to look for this Accounts Payable error is to review the A/P Aging 
Summary report. 

The Accounts Payable Aging Summary provides a quick snapshot on the outstanding bills as of a 
specific date.  Most of the amounts should be relatively current.  An extremely old amount may 
indicate an error or a situation that requires an adjustment.  Consistently old amounts due can 
indicate a profitability or cash flow situation that should be addressed immediately.  Any lines that 
have a zero balance in total show that all transactions have not been “linked.” (Credits have not 
been applied to the bills in question.) 

Excessive amounts in the >90 days column is an indication something is wrong: It is either a 
QuickBooks data entry procedural issue, which is what we will address here, or it could be 
indicative of a bigger problem with management or going concern issues, which we will not be 
addressing.  

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Reports > Vendors & Payables >  
A/P Aging Summary 
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ACCOUNTS PAYABLE FIXES 

The most efficient fix will vary based on several factors.  Most notable is determining if the client 
needs to prepare reports on the cash or accrual basis.  The second most important factor will be 
if the bank reconciliation has been completed or not. 

ACCRUAL BASIS – NO BANK RECONCILIATION 
If the client is on the accrual basis of accounting and the bank reconciliation has not been 
completed, the incorrectly entered checks can be simply deleted and you can re-enter them using 
the Pay Bills function.  One of the beauties of QuickBooks is that you can delete transactions and 
re-enter them correctly.  Don’t forget to back up the data file and print the check register or have 
the check copies in hand prior to pressing the delete button.  There is no “undo” or “undelete” 
available so be careful when using this alternative. Once you delete the checks you must then go 
in and Pay Bills to record the payment to the vendor. Having the check register printed up before 
you delete the checks will help you assign the correct check numbers and dates to the new bill 
payments. 

PATHS: Edit > Delete Check > Vendors > Pay Bills 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Lists > Chart of Accounts > Double click on 
Bank account > Single click on check to be deleted > Edit from the menu bar > Delete check 
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ACCRUAL BASIS – BANK RECONCILIATION COMPLETED 
For accrual basis reports, the bill and bill payment dates are critical.  If the payment to the vendor 
has already been entered as a check and the bank reconciliation has been completed, deleting 
the check as described above will change the beginning bank balance and with extensive delete 
and re-enter procedures, the likelihood of an error increases.  For this reason, the 
recommendation is to change the account code on the check to Accounts Payable.  This will 
create a credit on the Accounts Payable reports, which can then be linked to the bill.  The main 
trick to know when completing the correction in this way is that the vendor name will be required 
on the check detail line that contains the account of Accounts Payable. 

Step 1 – Correct Coding of Check 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Lists > Chart of Accounts > Double click on 
Bank account > Single click on check to be edited > Click on splits > Edit account to be Accounts 
Payable > Enter vendor in name column 

 

Record the change.  Complete this same procedure for all checks that should be linked to a bill. 
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Step 2 – Link Check to Bill 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Vendors > Pay Bills >  
Single click on the bill to be linked > Set Credits 

 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Vendors > Pay Bills > Single click on the bill 
to be linked > Set Credits > Choose credit to be used (note the same check number is in the Ref. No. 
column) > Done > Note that the credit used appears and the amount to pay is now zero 

 

Continue this process for all the bills and checks that need to be linked.  When the process is 
complete for all the transactions, click on the “Pay & Close” button.   
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A warning may appear that can be acknowledged that states in the older versions that no check 
will be generated.  The message in the newest version is: 

 

CASH BASIS – BILLS NOT NEEDED 
If the client is on the cash basis and accrual reports will not be needed for management, historical 
or any other purpose, it is possible to delete the bills.  The easiest way to delete the bills is to go 
to the Accounts Payable register and delete them.  By doing it in this way, it is easy to make sure 
the bill has, in fact, not been completely or partially paid. 

21 



Top 10 QuickBooks Mistakes Clients Make 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Lists > Chart of Accounts > Accounts 
Payable > Activities > Use Register > Single click on the bill to be deleted > Edit > Delete Bill 

 

If there has been a complete or partial payment linked to the bill, a different pop up box will 
appear: 

 

Once this process is complete, create the Reports > Vendors & Payables > Unpaid Bills Detail 
report to confirm everything looks OK. Note that the checks themselves are still listed in the 
Check Register – you may wish to review the expense account coding on the check to ensure 
accuracy on the P&L. 
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ACCOUNTS RECEIVABLE ERROR 

ERRORS & SYMPTOMS 
• Common Error: Make Deposit feature has been used rather than Receive Payments 

• Primary Indication: The A/R Aging report shows many old invoices. 

• Supplemental Symptoms: 

o Accounts Receivable is very high 

o Income is unreasonably high 

o The bank account balance looks right 

The quickest and easiest way to look for Accounts Receivable errors is to review the A/R Aging 
Summary report.   

This report shows, at a glance, who owes the business money.  It can be collapsed to show the 
amounts due by customer, or expanded to show the amounts due by job.   

Excessive amounts in the >90 days column is an indication something is wrong: It is either a 
QuickBooks data entry procedural issue, which is what we will address here, or it could be 
indicative of a bigger problem with management or going concern issues, which we will not be 
addressing. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Reports > Customers & Receivables >  
A/R Aging Summary 
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ACCOUNTS RECEIVABLE FIXES 

This fix is a little more complicated than that for Accounts Payable because typically the deposit 
includes several customers and there is a limitation within QuickBooks that a single transaction 
can only have one A/R or A/P type account.  For this reason, using the receive payment feature is 
recommended.   

NOTE: The only exception would be if a client is so excited every time they receive a payment they 
run to the bank immediately.  If each amount is deposited separately, similar procedures of changing 
the account code to Accounts Receivable would be possible.  This, however, is the exception rather 
than the general rule. 

BANK RECONCILIATION NOT COMPLETED 
If the bank reconciliation has not been completed, the easiest way to deal with the issue is to 
delete the existing deposits.  Re-enter the amount received using Receive Payments and 
undeposited funds.  And then make the deposit to link all the payments together as one 
transaction in the check register, to match what was actually deposited in the bank. 

Step 1 – Delete Deposit 
This step will remove the incorrect deposit from the QuickBooks data file.  As with any other fix, 
be sure you know everything there is to know about the transaction prior to deleting it. This 
includes the date, amount, check number, customer/job, and any other information that may have 
been entered.  This information will be needed when the transaction is re-entered correctly. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Lists > Chart of Accounts > Double click on 
Bank account > Single click on deposit to be deleted > Edit from the menu bar > Delete deposit 
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Step 2 – Receive Payment 
This is the step that records the link between the money that was received and the invoice 
previously generated for the customer: job.  As was mentioned above, the general rule is that all 
receive payments should be recorded as grouped with undeposited funds. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Customers > Receive Payments 
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Step 3 – Make Deposit 
This step is the process that combines several payments that have been received from various 
customer: jobs into one deposit that will match the amount received by the bank. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Banking > Make Deposit 

 

28 



Top 10 QuickBooks Mistakes Clients Make 

BANK RECONCILIATION HAS BEEN COMPLETED 
If the bank reconciliation has been completed, the easiest way to deal with the issue is to enter 
the amount received using Receive Payments and undeposited funds.  And then edit the deposit 
to link all the payments together as one transaction in the check register. 

Step 1 – Receive Payment 
Follow the same procedures as Step 2 above. 

Step 2 – Edit Deposit 
With the deposit on the screen, note the deposit total amount.  This is critical to keeping the 
beginning bank balance amount on the reconciliation unchanged. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Lists > Chart of Accounts >  
Single Click on the deposit > Edit > Edit Deposit 

 

Next, click on the payments button (at the top of the “Make Deposit” pop-up screen) to permit 
including payments that should be included on the deposit.   
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QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Lists > Chart of Accounts >  
Single Click on the deposit > Edit > Edit Deposit > Click on Payments Button 
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This next step will “pull” the receive payment onto the deposit slip. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Lists > Chart of Accounts >  
Single Click on the deposit > Edit > Edit Deposit > Click on Payments Button >  
Select payments to be included on deposit > OK 

 

Note that the deposit is now listed twice. 
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This next procedure will clean up the deposit slip and delete the previous incorrect entries. Single 
click on the deposit to be deleted, and from the edit menu, choose delete line. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Lists > Chart of Accounts > Single Click on 
the deposit > Edit > Edit Deposit > Click on Payments Button > Select payments to be included on 
deposit > OK > single click on the incorrect line > Edit > Delete Line (repeat if there are multiple 
detail lines to be deleted), confirm the deposit total agrees with the starting deposit 

 

NOTE: Be sure only to delete the deposit that does not have a “Received From” name associated with 
it!  Otherwise you will be deleting the deposit you just entered in the prior “Receive Payments” step. 
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DEPOSIT DATA ENTRY CASE STUDY  

Q – My accountant just informed me that I have been doing my deposits all wrong. I had been 
entering an invoice to send to the customer then receiving the payment to show the invoice was 
paid. I looked in the check register and did not see the money, so I entered a deposit which 
agrees to the bank statement. Now I have a big mess because the income has been recorded 
twice (once from the invoice and once from the deposit). What can I do now to fix the problem? 

A – There are two alternatives, depending on the volume of transactions. One is to "reconcile" 
the deposits as of specific dates; the other is to fix the detail. 
The fastest solution is to make a deposit each month by checking off all the receive payments for 
the month. Then say OK to "pull" these transactions onto the deposit slip, and then enter one line 
as a negative amount coded to the general ledger account where the previous deposits have 
been recorded. This will, in effect, reclassify the undeposited funds amount against the incorrectly 
recorded income.  

The solution that will provide a clean trail of what has actually happened would be to "pull" the 
receive payments onto the deposit slips. This can be done by editing the deposit, click on the 
payments button at the top, place a check mark next to each receive payment that should be 
included for the deposit, say OK to return to the deposit slip, delete the incorrect detail line (note 
that the deposit amount should still be the same as when the process began). The disadvantage 
is that this process can be time consuming. However, if the deposit total does not change, it will 
not affect any of the bank reconciliation work already completed. That is the reason for changing 
the deposit as opposed to deleting it.  

NOTE: If the receive payment option had not been used (i.e., the invoices were entered and the 
deposits entered directly onto a deposit slip or into the register) and there was only one payment per 
deposit slip, the most efficient correction may be to change the general ledger account code to 
Accounts Receivable. This method would require the customer: job in the name column. If multiple 
payments were deposited together, one of the options above would be needed. A second step of 
"linking" the invoice to the credit/payment would be required through the receive payments form. 
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ACCOUNTS RECEIVABLE/BANKING BONUS TIP 

Since the 2007 version, there have been additional receive payment preferences.  In addition to 
some layout changes, the most significant change is the ability to automatically calculate 
payments and use undeposited funds as a default deposit account.  This is a company 
preference, so in order to make any changes; the user must be logged in with the “Admin” 
password. 

PATH: QUICKBOOKS: PREMIER 2008: ACCOUNTANT EDITION Edit > Preferences > Sales & 
Customers > Company Preferences 

Select to “Use Undeposited Funds as a default deposit to account.  Previously the choice to 
group with undeposited funds or deposit directly into the bank account was on each receive 
payment and sales receipt form. 
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BANK DEPOSIT ERRORS 

ERRORS & SYMPTOMS 
• Common Error: User has followed an incorrect procedure, or simply is not familiar with 

QuickBooks. 

• Primary Indication: Deposits do not match bank statement 

o Individual amounts appear in QuickBooks versus total deposit amount on bank 
statement 

o Net credit card deposits appear on the bank statement but gross deposits appear 
in QuickBooks 

o Miscellaneous deposit information is missing (i.e., vendor refund, loan proceeds, 
etc.) 

Most of the bank deposit related errors are the result of incorrect procedures or users who are 
unfamiliar with QuickBooks features.  The more closely the deposits in the bank account register 
match the statement that is received from the bank, the more efficient the bank reconciliation 
process becomes. 

Some typical reasons why deposits do not match bank statement: 

• Individual amounts appear in QuickBooks versus total deposit amount on bank statement 

• Net credit card deposits appear on the bank statement but gross deposits appear in 
QuickBooks 

• Miscellaneous deposit information is missing (i.e., vendor refund, loan proceeds, etc) 

Simple changes such as calling the bank to request month end cut off (the bank statement cycles 
on the final day of the month) and the statement in check number order can greatly enhance the 
ease of using QuickBooks to reconcile the data with the bank’s reports. 

Other differences, such as those listed above, require a little training for the client, but the result is 
a much more effective use of QuickBooks in the long term. 
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BANK DEPOSIT FIXES 

Most clients arrive at the right answer (assuming they are completing the bank reconciliation 
process with a difference of zero) even if they do not follow the procedures below.  For this 
reason, the “fix” should only be used for correcting the information since the last bank 
reconciliation.  This serves as a training exercise so the client follows the correct procedures 
going forward and will make the next bank reconciliation easier.  The importance of this approach 
is that it is much easier to record deposits that match the bank statement amounts as the 
information is entered, rather than trying to go back and “guess” what is included when 
completing the bank reconciliation. 

To implement these fixes, first edit Receive Payments and Sales Receipts transactions to group 
with undeposited funds for the time period that has not yet been reconciled then complete the 
Make Deposit procedures, and finally, reconcile the bank statement. 

PATH: Banking > Make Deposits 

Once payment detail, if any, has been “pulled” onto a deposit slip, enter additional money 
deposited from non-customer sources and/or credit card fees to be deducted to arrive at the net 
deposit amount received by the bank. You can use the cash-back area to deduct any money the 
business owner took form the deposit when he/she was at the bank. 

CORRECT CODING ON RECEIVE PAYMENT OR SALES RECEIPT FORM 
The easiest way to correct the previous receive payments and sales receipts forms is to start at 
the end of the register and double click on the amount in the deposit column.  This will “drill down” 
to the actual transaction which can then be re-coded by clicking on the pull down list and 
choosing undeposited funds.  At that point, the amount has been removed from the register and 
is now available on the Make Deposit screen. 
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QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Home Page > Use Register > Choose 
correct bank account > Find deposit in question > Click on Deposit > Choose Edit Transaction” > 
Choose Undeposited Funds for the “Deposit To” account. 

 

TIP: This procedure is only used if the “Use Undeposited Funds as “Deposit To” 
bank account is not checked.  If this selection is not checked, there is an option on 
the “Receive Payment” window.  In addition, do not follow these procedures if the 
bank reconciliation has already been completed or there will be a beginning balance 
variance with the next reconciliation. 
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MAKE DEPOSIT PROCEDURE 
This function is for depositing checks received from customers or for recording miscellaneous 
amounts received from sources other than customers, such as loan proceeds, rebates, etc.  The 
latter can be added to a deposit slip that has been created from undeposited funds or as a 
separate transaction. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Home Page > Make Deposit  

 

NOTE: The “Payments to Deposit” screen appear only if there are payments that have been entered 
and posted to undeposited funds; once the appropriate amounts have been marked for the deposit slip 
and OK has been chosen the “Make Deposits” screen will appear.  
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QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Banking > Make Deposit  

 

NOTE: If the screen is empty, it means there are no undeposited funds waiting to be deposited. If you 
have in fact received payments from customers, and are expecting to see deposits here, it probably 
means you have invoked a bank account or the Receive Payments screen. Go to the Register for that 
bank account and drill down to correct the deposit to Undeposited Funds, then Make Deposits. 

TIP: As an internal control procedure, print the deposit slip from within QuickBooks and attach the 
bank receipt to the printout of the deposit slip. This also makes investigation of any bank 
discrepancies much easier. 
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NON-CUSTOMER DEPOSITS 
Non-customer deposits are relatively rare in most QuickBooks files, but for some businesses they 
are common.  The main trick to remember is that the amounts can be subsequently included on a 
deposit slip with customer receipts. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Banking > Make Deposits > Check the 
customer payments to be deposited together > OK > Click on the first blank line of the deposit slip 
(may require scrolling down and/or clicking on the last undeposited funds line then using the down 
arrow) > Enter the non-customer deposit information 

 

BONUS INFORMATION: VENDOR REFUND OF OVERPAYMENT 
Depending on how the original payment was made will dictate how the refund will need to be 
recorded.   

A) If the bill/bill payment method was used, the vendor should currently show an overpayment on 
the account.  To record the return of the overpayment, the amount can be entered on a deposit 
slip with the vendor name and coded to Accounts Payable.   

B) If the amount was originally paid with the write check method, the deposit will still be recorded 
on a deposit slip.  The change will be that the code should be to the same expense account as 
the original overpayment.  The two amounts will then “net” leaving the remaining true expenditure 
balance in the affected GL expense account. 

BONUS INFORMATION: REFUND FROM VENDOR FOR RETURN 
Return of an item – First enter a credit for the item(s) to be returned by placing the mark next to 
credit at the top of the bill form and complete the bottom of the form based on the details of what 
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was returned.  Typically this will be the same information as the original transaction.  Then enter 
the refund as detailed in part A above.   

Return other than items – If the return was for something other than an item, part B above will 
provide the steps necessary to correctly record the refund. 

NET CREDIT CARD DEPOSITS 
As you process the credit cards as either sales receipts or through the receive payment function, 
be sure to mark the radial circle to “group with other undeposited funds.”  Entering the payment 
method is helpful since different credit card types are typically transferred to the bank account in 
total. 

The next step is to choose to make deposit from the banking pull down.  All the customer 
payments will appear and those to be deposited together can be chosen by placing a check mark 
next to each one, or by choosing the select all button towards the bottom of the screen.  New with 
version 2004 is the ability to only show payments of a certain type.  This helps to streamline the 
process of choosing those payments that are included in one deposit into the bank account. 

If the amount is received from the credit card company net (i.e., the credit card company keeps 
their fee from each deposit) it is possible to enter the fee directly onto the deposit slip with a 
negative amount.  There is a calculator function built in, so if the fee is a percentage of the total 
deposit, press – then type the number, then press the * key to multiply and then the percentage 
as a decimal (i.e., 3.45% is .0345) and then enter to have the computer calculate the fee.  The 
fee will appear as a negative number to reduce the total deposit amount.  The result is a total 
deposit that should match the bank statement. 

TIP: If there is a discount fee and a transaction fee, it may be easier to sign up for on-line banking and 
complete the make deposit function once the deposit is actually received into the bank account if the 
day to day balance is important.  With most credit card processing companies they also have an online 
reporting function to see the actual deposit detail information in real time. 

TIP: If the business does not need an “up to minute” accurate bank balance, it may be acceptable to 
enter the deposit at gross (amount received from the customer in total) and then enter the credit card 
processing fees monthly (keeping in mind that QuickBooks will always be a little higher than the 
bank until the adjustment is entered).  Each credit card company supplies a statement either on-line 
or through the mail that will show the individual charges less the fee for each deposit that can be used 
to reconcile the deposits manually. 
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NET CREDIT CARD DEPOSIT CASE STUDY 
Customer ABC owes invoice 123 in the amount of $1,000.00.  They call and say they would like 
to pay for the invoice using their American Express Credit Card.  The business accepts American 
Express as a form of payment and receives the amount net of an American Express fee of 
3.45%.  The credit card number and related information is obtained from Customer ABC and a 
Receive Payment is entered into QuickBooks for $1,000.00 with the payment method of 
American Express.  

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Home Page> Receive Payment 

 

NOTE: If the Merchant Service is provided by QuickBooks, the payment will be automatically 
processed when saving the transaction by marking the checkbox.  Otherwise, the appropriate method 
of processing will need to be completed (for some businesses it is processing the charge through a 
machine, for others there is an on-line alternative).   

In this case the deposit will be received net, but the discount is known (keep in mind there may be 
a transaction fee or other fees in addition to the discount fee for some credit card merchant 
accounts).  In this type of circumstance (or if the deposit was received gross and the fees taken 
out separately) it would possible to process the deposit immediately in QuickBooks.  First choose 
the Receive Payment that was just entered — this will “pull” the amount onto the deposit slip — 
then click on the line below the Receive Payment and enter the account (typically bank service 
charges, credit card processing fees, or something similar), optionally enter American Express as 
the payment method and -34.50 in the amount column.  Tab or click to the next line and the net 
deposit amount should be $965.50.   
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QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Banking > Make Deposits > Click on 
Payment to be deposited > Click on line below undeposited funds > Enter credit card fee information 
> Click on the next line > Confirm the deposit total that will be received by the bank 

 

This process will correctly show the customer balance paid in full (i.e., the customer paid $1000 in 
full using their American Express), the discount is correctly reflected as a business expense, and 
the deposit into the bank account is also correctly reflected.  The only other issue to keep in mind 
is that typically the deposit will take several days to “clear” the bank from the credit card company 
(so don’t spend the money too quickly). 
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PAYROLL LIABILITIES ERROR 

Payroll (and inventory which we will discuss later) are the two areas where QuickBooks is less 
forgiving and clients are more likely to make mistakes. 

Most often the errors are the result of incorrect or inconsistent procedures. 

The most common error in this area is that the “Pay Payroll Liabilities” feature was not used; 
rather payroll tax payments were entered using “Write Checks.” 

Common Symptoms are: 

• Payroll Liabilities are higher than expected 

• Payroll Tax Expense are higher than expected 

• Bank account balance is OK 

• Payroll tax returns have been prepared and filed showing no balance due (and no notices 
to the contrary have been received) 
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PAYROLL LIABILITIES FIXES 

PAYROLL LIABILITY PAYMENT  
Following proper procedures for the payment of payroll tax liabilities is imperative. If the 
procedures are not followed, the payroll liability report, as well as the payroll tax returns, will not 
be accurate. There is no way on the bill or check screens to tell the software which specific 
payroll items are being paid.  The Pay Payroll liabilities feature must be used to correctly 
designate the payroll items that are being paid. 

Other liabilities, such as garnishments, union dues, health insurance, 401K, etc. should also be 
paid regularly using the pay payroll liabilities option shown below.  If these amounts are not paid 
in this way, it is possible to do a payroll liability adjustment and not affect the accounts (update 
the items but not the general ledger). 

The steps to follow are: 

• Correctly process the payroll liability check payments using the dates and marking the 
liabilities for amount actually paid. 

• Assign the appropriate check number in the register  

• Delete the incorrect check  

NOTE:  It may be necessary to clear the liability checks with the next bank reconciliation  
(i.e., beginning balance will be off by the amount of these checks) 

The date range for the liabilities is important for the payroll liability reports and subsequent payroll 
tax returns.  This is the way that QuickBooks knows which period the payment should be applied 
to.  (Bonus Tip: Clients often do not understand the “period end” versus “check date” concept) 

The second critical date is the check date.  This is the date the payment is generated and will be 
recorded as a reduction in the liability and reduction in the bank account balance. 

QuickBooks will accept alpha-numeric check numbers so EFT, for example, is acceptable if the 
payment was made electronically. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Employees > Payroll Taxes and Liabilities > 
Create Custom Liability Payments > Choose date range 

 

NOTE: If the QuickBooks Standard Service (previously the Do It Yourself Payroll Tax Service) is 
used, the software will show the amounts due for the time period, but will not remind the user to 
actually pay the payroll taxes and liabilities.  Use the look back period test to see if the client needs to 
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change their payroll tax liability payment frequency.   The state agencies also have their own 
guidelines.  If the business bookkeeper or owner is unsure as to when the taxes should be paid, a call 
to the accountant or governmental agency should clarify the situation.  Penalties and interest add up 
fast, so tax payments become very expensive if they are paid late. 

TIP: To make sure everything is in balance with the payroll, compare the general ledger liability 
balances, the payroll liability summary for the year to date, and the payroll liability summary with the 
date changed to “All”.  All three reports should be the same. 

NOTE: Electronic Tax Payments and Electronic Returns – If the Assisted Payroll Tax Service 
(previously Deluxe) is being used, the service pays the Federal and State taxes electronically on behalf 
of the company.  If other liability checks need to be issued, the same procedures as detailed earlier 
should be followed.  When the Employee > Pay Payroll Liabilities option is chosen; the federal and 
state amounts will not appear.  Only any additional liabilities will be available for payment (such as 
health insurance, 401K, etc). 

TIP: New with version 2008 is a new payroll service called Enhanced Payroll Service. There is also an 
edition available to Accountants knows as Enhanced Payroll Plus for Accountants.  The expanded 
functionality of this service includes net-to-gross calculations, workers compensation tracking, state 
payroll returns for approximately 40 states, and processing payroll for up to 50 clients when done on 
the same registered copy of QuickBooks.  For a comparison of all the Intuit Payroll Services, visit 
http://www.payroll.com/comparisonchart.html  

CORRECTING THE BANK REGISTER 
When the payroll liability check was entered correctly, the result was two payments in the bank 
register.  When deleting the previous entry, the double entered check is that has the “CHK” type 
payment should be deleted; the “LIAB CHK” type payment is the correct payroll liability payment 
and should remain. 

 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Home Page > Check Register 
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Although the bank reconciliation beginning balance may be off if the erroneous checks were 
already marked as cleared, there is not any way to avoid this. The beginning balance should be 
too high for the amount of the liability checks, mark those liability checks as cleared as part of the 
reconciliation, and the difference at the end of the process should be zero. Your next bank 
reconciliation should be fine. 
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LOAN BALANCE ERRORS 

Loan related transactions are always more challenging for clients, and as a result, errors are quite 
common.  Often the loan was not recorded to begin with so the payments are simply expensed as 
they are paid.  Or, the entire payment is assigned to the liability if the loan has been recorded 
(typically by the Accountant). 

Some indications may be: 

• loan balance or interest expenses do not look reasonable 

• loan balance or interest expenses are too high for both if entire payment coded to the 
expense account  

• loan balance or interest expenses are too low for both if the entire payment was coded to 
the liability account 

The existence of the loan may be discovered because of an increase in an expense account such 
as Automobile expense or Office expense.  

Some accountants choose to handle this issue themselves each time they do the work, others 
choose to provide the loan amortization schedule to the client (or have the client obtain it from the 
lender or from loan statements) and train them to correctly split the transactions going forward. 
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LOAN BALANCE FIXES 

JOURNAL ENTRY 
General journal entries have long been the accountant’s “domain.”  Although many of the 
adjustments that need to be made are handled more effectively by using a QuickBooks form (i.e., 
payroll, inventory, information for sales reports, etc), there are certain instances when creating a 
journal entry is the only way to enter the transaction.  This includes Accountants who are using 
the Accountant’s Review Copy with their clients, loan adjustments, depreciation, fixed asset 
correcting entries, etc.  Assuming entering the transaction as a journal entry does not have any 
reporting or feature implications; the adjusting journal entry feature expands the reporting 
capability for work paper preparation for the accountant:  

• Adjusting Journal Entries Report 

• Adjusted Trial Balance, and  

• Working Trial Balance. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Company > Make General Journal Entries 

 

TIP: The ability to set a preference to have the software automatically, sequentially number the 
journal entries was new with version 2002.  New with version 2003 was the ability to see a specific date 
range of journal entries on the screen below the journal entry input screen. 
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The new addition for QuickBooks: Premier – Accountant Edition version 2004 is the ability to 
mark a journal entry as an adjusting entry by clicking on the check box.  This small change has 
large implications to increase the flexibility of reports.  For example, the adjusting column (a 
check mark in this column designates the entry was an adjusting entry) has been added to the 
default format for the following reports: 

• General Ledger  

• Journal Reports  

• Profit & Loss Detail  

• Balance Sheet Detail  

• Transaction Detail by Account  

• Transaction List by Date  

• Audit Trail  

• Income Tax Detail  

NOTE: The ability to filter a report for only the adjusting journal entries is not available. 

With Version 2003, there are also two new reports designed specifically to streamline the process 
for accountants: the adjusted trial balance that includes the unadjusted balance, adjustments, and 
adjusted balance columns; and the adjusting journal entries report which is a report of only the 
entries for the time period that have been designated as adjusting journal entries. 

New with version 2008 is the ability to have the adjusting entries appear on a working trial 
balance report. 

CORRECT PREVIOUS ERRORS 
Alternative: Correct bills and/or checks to split each payment to the liability and expense as 
necessary 

Correcting the previous errors will provide a clean historical record.  Correcting coding errors with 
subsequent journal entries will result in a more complicated audit trail.  Plus the client is more 
likely to continue to make the same mistakes if they go back and look at a previous transaction, 
so ideally each transaction would be corrected individually and properly coded.  There are several 
ways to find the previous transactions to make the corrections when using QuickBooks. 

Find Feature 
The find feature is so easy to use compared to many other software packages.  The “Ctrl+F” is 
the key stroke for the feature.  The advanced tab is for general look ups (and is the only option 
available in older versions) whereas the simple tab is to find specific types of transactions.  With 
either tab, enter what you know and QuickBooks will find the transactions that match the criteria. 

New with Version 2008 the find feature will default to tab that was used last.  With 2008 the Detail 
Level default was changed back to “All” rather than “Summary” as was the case in a few of the 
previous versions. 
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Besides the find feature, there are several ways to find a transaction that has already been 
entered.  

• On all of the forms there is a previous and next button that can be useful. This is not 
usually the most efficient method since QuickBooks places all the transactions in date 
order as they are entered.  This is not in the order entered, so if bills have been entered 
through 8/31/03 and a bill is entered dated 7/30/03, to find it would require pressing 
previous through all the August transactions. 

• A more efficient method may be to use the register. This is also in date order, but it is 
easier to scroll up and down through the list. If a form is open on the screen (a bill for 
example) pressing Ctrl>R will open the appropriate register (in our example the Accounts 
Payable register). Once you find the transaction, double click to open the specific 
transactional form.  The register can also be entered from the chart of accounts list. 

• If you see a transaction on a report and would like to see detail about it, place the cursor 
on the line of the transaction. It will change into a magnifying glass. Double click and you 
will zoom to the detail.  

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Edit > Find > Advanced 

 

NOTE: It may be necessary to click on the history to drill down to the bill from the bill payment check 
to correct the coding.   
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QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Home Page> Check Register > Find Bill 
Payment > Edit Transaction> History 

 

The benefit of finding the incorrectly recorded transaction and fixing it is that with the automatic 
recall preference turned on, the change in account and coding will automatically appear when the 
next payment is entered.  By default this preference is not checked so to use the feature will 
require turning it on. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Edit > Preferences> General >  
Automatically recall last transaction for this name or Pre-fill accounts for vendor based on past 
entries 

 

Bonus Fix – Use the Loan Manager (2004 - Pro and higher) in the future to automatically 
amortize the loan payments (Banking > Loan Manager) 
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FIXED ASSET ERRORS 

• Common Errors: 

o Expense has been recorded for the loan payments but the asset and liability 
have not been recorded  

o The loan account was created with an opening balance on the new account set 
up screen 

• Primary Indications: 

o Review Accumulated Depreciation for appropriate balance and entries 

o Balance Sheet figures are incorrect in Fixed Asset area 

• Supplementary Symptom: Consider operating versus capital leases 

• Bonus Errors: 

o Purchases that should be capitalized are expensed 

o Purchases that should be expensed are recorded to the fixed asset account 

 Recording the fixed asset purchase is not usually a transaction that the client thinks about, or, if 
they do, they do not know how to record it correctly.  Due to the infrequent nature of this type of 
activity, do not assume consistency on the part of your client. 

The first step is to figure out what has and has not been recorded 

The next step is to determine if the accounts that will be needed exist on the chart of accounts 
(i.e., fixed asset, other current liability, long term liability, loan interest) 

Then you can begin to figure out how to fix it. 
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FIXED ASSET FIXES 

JOURNAL ENTRY 
As was described in the previous section, a journal entry is an effective way to deal with 
reclassifying and/or recording a fixed asset transaction.  To record the transaction correctly, 
obtain the bill of sale or other paperwork that supports the purchase.  This paperwork should 
detail any additional costs that should be capitalized (such as delivery and/or installation), as well 
as any amounts that can be expensed in the current period (for example the license fee for a 
vehicle purchase).  Prior to making the entry, it is also important to discover what has been 
already recorded in QuickBooks: was there a down payment, if so, how was it recorded; have 
there been loan payments made already, how were they recorded; has the fixed asset and/or 
loan accounts been created on the chart of accounts, if so, was any activity already entered onto 
the register?  Once the determination has been made as to what was recorded, it is simply a 
matter of creating a journal entry to reclassify everything correctly. 

PATH: Company > Make Journal Entries; see also Loan Errors 

FIXED ASSETS CAPITALIZATION POLICY 
Although this question is primarily accounting policy in nature, the answer is important when 
determining if the fixed asset section has been handled properly.  A capitalization policy is a 
materiality threshold for when a purchase is recorded as an asset versus expensed in the current 
period.   

The general rule is: If an asset has a life that exceeds one year, it is an asset.  For example, a 
computer or a garbage can has a life of greater than one year where as a pad of paper does not.  
The capitalization policy is determined based on the size of the company and the typical size of 
expenditures.  In our previous example, capitalizing a $10 garbage can (and depreciating it $2 a 
year for the next five years) does not make sense from the standpoint of keeping track of it, 
placing it on the schedule for tax return purposes, and making the entry each year to depreciate 
it.  A $2,500 computer system, on the other hand, should be handled properly.  For most small 
businesses, the limit is usually around $500, but this can vary depending on the type of business, 
typical expenditures, etc. 

FIXED ASSET MANAGER 
In QuickBooks: Premier 2004 (and higher): Accountant Edition, there is a built-in Fixed Asset 
Manager that you can use to easily track your clients’ fixed assets and generate automatic 
depreciation journal entries into their books each month. 
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PRIOR PERIOD CHANGES 

One of the most frustrating things for Accountants using any software is when they begin the 
work for the new period and the prior period balances have changed. 

In QuickBooks this is part of the double edged sword of easy to use and correct, but incorrect use 
of the safeguards and good accounting controls can be problematic. 

The solution involves a more active role by the accountant to ensure that their entries have been 
processed and recorded correctly. More extensive client training might be needed. Next use the 
tools available within the software to discover what has been done, and then fix it. 
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PRIOR PERIOD FIXES 

VOIDED/DELETED TRANSACTIONS 
With version 2007 (Pro and higher) is the Voided/Transactions Report.  This is an easier way to 
see which transactions have been voided or deleted for a specific time period.  This is a summary 
report so it is possible to double click on the specific entries to drill down to the transactional 
history report to see the detail. 

REPORT PATH: Reports > Accountant & Taxes > Voided/Deleted Transactions Summary or Detail 

When the report is opened for the first time, a warning pop up box appears: 

“This version of QuickBooks tracks transactions that you void or delete and displays them in this 
report.  It does not display transactions that you voided or deleted using any QuickBooks version 
prior to QuickBooks 2008. . . “ 

 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Reports > Voided/Deleted Transactions 

 

Internal Control Note: This report does show transactions that were voided or deleted in the same 
session. 
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AUDIT TRAIL 
Although QuickBooks does not have the same enter, print, and post routine as many other 
software packages, it does have an audit trail report. For versions 2007 and higher, the audit trail 
is automatically turned on.  In the past, you needed to turn on the audit trail.  This is no longer 
necessary. 

 

TIP:  In order to make this report efficient and effective, it is imperative to set up users for all 
individuals working in the data file. 

 

Establish a user name and password unique to each person who will be using the software.  In 
addition to the date and time, the user is also tracked.  

TIP: The audit trail function works well for supervising data entry by others since it is possible to do a 
report of all the transactions entered/modified for a specific date range.  

Comparison of the Financial Statement reports as prepared by the Accountant and the current 
balances as of the same date in QuickBooks will often provide clues as to what transactions may 
have been changed: For example, is cash significantly lower in QuickBooks?  Was an old 
outstanding check deleted or voided?  Was a bank fee subsequently recorded in the previous 
period and manually cleared? 

CLOSING DATE 
It is recommended that the closing date be assigned regularly, usually after the bank 
reconciliation and financial statements have been prepared for the previous month.  Because this 
information is on the company preference, only the Admin password can change it, another 
reason to not allow any other user to know the Admin user. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Edit > Preferences > Accounting > Set 
Date/Password 

 
 

NOTE: Since this change is a preference, the Admin is the only user who can change this password. 
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In a perfect world, transactions would be entered, accounts would be reconciled, and financial 
statements would be issued at which time the closing date would be updated. In reality, most 
small businesses do not use the reports available as often as they should and therefore do not 
institute the procedure of closing the period. Instead, they take the approach that corrections and 
reclassifications can be made throughout the year until the time when the accounting records are 
sent off to the accountant. It is the opinion of this author that that type of business management 
may be acceptable when there is only the owner, who is also the bookkeeper, who is also the 
sole decision maker. Once that situation changes, it is important to review reports timely and to 
revise the closing date so that reports that have been reviewed in prior months do not change. 

PASSWORDS  
As QuickBooks becomes more widely used as a bookkeeping tool by small business owners, the 
concerns and issues raised by accounting professionals deserve some attention. Although the 
computer operating system itself may have passwords, the additional level of security of 
password protecting the data itself is usually prudent.  Based on the experience of this author, the 
most common concern relates to the audit trail: the ability to change entries after they have been 
recorded. Using passwords and permissions in QuickBooks is required to reduce the likelihood of 
this happening.  There is a double edged sword in QuickBooks because the data can be quickly 
and easily corrected when mistakes happen, but it can also be easily changed after the books 
have been reconciled, financial statements issued, and/or the tax returns have been filed.  The 
password protection feature and related closing date helps to reduce the likelihood of such 
problems when used consistently.  In addition, the 2002 version and higher of QuickBooks: 
Premier also has several new reports to assist in finding such changes. 

Each firm that is going to provide bookkeeping services will need to determine what the password 
procedures and protocol will be. For example, is the Admin password going to be the same for all 
clients, what about the user names? And who has access to the Admin password? 

Each person should be setup individually. The designation of the specific areas of the software 
that the user is allowed to work in, as well as limiting the activities a user can perform, offers 
improved flexibility by releasing certain functions to permit effective and efficient use of the 
program.  The password feature within QuickBooks continues to serve several functions: 

• Protection of prior period data from accidental changes by setting the closing date 

• Restricted access to confidential information by creating individual user passwords 

• Protection of data from changes by unauthorized users 

• Tracking data entry of various users  
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Password Set Up 
The following set up instructions is for QuickBooks products versions 6 and higher as well as 
Enterprise Solution through version 4. For Enterprise version 5, the set up process has been 
completely changed, allowing over 100 different levels of customizable permissions per user. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Company > Setup Users and Passwords > 
Set up Users 

 
  

For each new user, selected areas of QuickBooks should be chosen to permit limiting access to 
adding, deleting, or changing transactions in a closed period.   

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Company > Setup Users > Add User > 
Selected Areas of QuickBooks 
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Each user should be set up individually.  If there are multiple QuickBooks data files the 
passwords will need to be set up for each one.  The specific areas that are available for no 
access, full access, or selective access (i.e., create transactions, create and print transactions, or 
create transactions and generate reports) are as follows: 

Sales and Accounts Receivable  

Purchases and Accounts Payable 

• Checking and Credit Cards 

• Inventory 

• Time Tracking 

• Payroll 

• Sensitive Accounting Activities (includes online banking, transfer funds,  
and journal entries) 

• Sensitive Financial Reporting 

• Changing and deleting transactions in A) permitted areas and/or B) closed periods 

The first areas are determined based on the functions that the user will perform or need access 
to.  The last two options, however, deserve additional clarification.   

A) is a choice to let the user change or delete transactions in the areas that they have 
been given access.  This, like so many issues in QuickBooks can be a blessing and a curse.  For 
example, if User A creates an invoice and prints it (which automatically will save the transaction) 
and then realizes that a typographical error has been made in the description section, should this 
person be able to go back and correct it, save it, and reprint it?  From an operational standpoint, 
the answer is probably yes, it happened right then and the hassle of explaining the change to 
User B (with the Admin password) and User B making the change can be cumbersome.  
However, from an internal control standpoint, providing User A with the ability to change 
transactions in specific areas means that an invoice could be created, printed and sent, then 
subsequently voided, changing the accounting data.   

B) for all users should be No, do not permit changing or deleting transactions in a closed 
period.  If a change does need to be made, for example final adjusting journal entries from the tax 
accountant, the Admin user can make those changes.  The reason that it is important that no one 
else have that ability pertains to users who do not understand the software or do not have enough 
accounting knowledge to understand the potential problems of changing prior period data.  For 
example, a check has been outstanding for several years and the bookkeeper is assuming it 
should be voided.  If the check is simply voided, the accounting history will change from the date 
of the original check because this transaction is now zero.  When the accountant begins the year 
end work the Retained Earnings balance has changed.  This creates the challenge of finding out 
what happened. Saying No to this choice is very cheap insurance to force well-meaning 
individuals (with access to the Admin password) to go through a few additional steps to change 
history.  To make the process of discovering the changes easier, new with QuickBooks: Premier 
Version 2008 is an additional report to track these changes.  The Closing Date Exception Report 
is located on the Report menu under Accountant and Taxes. 

With this enhancement, real time user tracking is available, and the audit report has been 
modified to include the user responsible for entering/modifying specific transactions. 
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NOTE: It is not possible to give a user access to only view reports but not enter new transactions.  It is 
possible to remove the ability for a user to change or delete existing transactions.  Setting a closing 
date can remove the ability for the user to enter transactions prior to the closing date.  But with all the 
alternatives, if they can view reports, they can enter new transactions with dates from the closing date 
into the future. 

TIP:  The first time you setup passwords, you will be asked to enter a password for the user name of 
“Admin”.  Do not change this name to someone’s actual name: leave it as Admin.  This provides an 
extra level of security and protection for the data.  There are certain functions that only the Admin 
user can perform, so be sure to write down in a safe place (or several) what this password is. 

TIP: Change passwords regularly and definitely when an employee has been terminated. 
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PASSWORD SET UP CHECKLIST 

 
User Name:  Password:  Selected/Full 
Features None Full Selective/Create Selective/Create & 

Reports 
Sales/A/R     
Purchases/A/P     
Checking/CCd     
Inventory     
Time Tracking     
Payroll     
Acc’tg Activity     
Financial Rept     
Change/Delete Areas they 

have access: 
Yes 
No 

Closed Periods: Yes 
No 

 
User Name:  Password:  Selected/Full 
Features None Full Selective/Create Selective/Create & 

Reports 
Sales/A/R     
Purchases/A/P     
Checking/CCd     
Inventory     
Time Tracking     
Payroll     
Acc’tg Activity     
Financial Rept     
Change/Delete Areas they 

have access: 
Yes 
No 

Closed Periods: Yes 
No 

 

User Name:  Password:  Selected/Full 
Features None Full Selective/Create Selective/Create & 

Reports 
Sales/A/R     
Purchases/A/P     
Checking/CCd     
Inventory     
Time Tracking     
Payroll     
Acc’tg Activity     
Financial Rept     
Change/Delete Areas they 

have access: 
Yes 
No 

Closed Periods: Yes 
No 
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INVENTORY ERRORS 

ERRORS & SYMPTOMS 
• Common Error: Incorrect and/or inconsistent inventory procedures 

• Primary Indication: Inventory Valuation Summary report does not look right 

o Inventory quantity is negative to too high 

o Average cost looks too high, too low or zero 

• Supplemental Symptom: Asset Value does not agree with the General Ledger 

• Bonus Errors:  

o Inventory is sold before it is purchased  

o Unit of measure is not used consistently 

o Products that are used by the business or given as samples are not recorded 

Inventory, along with payroll, is consistently one of the most problematic areas for clients who are 
doing the bookkeeping themselves.  While the process seems straight forward, incorrect and/or 
inconsistent procedures create errors that can be more challenging to correct. 

The first issue, before any work is done on the file, should be to determine if inventory type parts 
are appropriate for the client or if their needs be better served with non-inventory parts where the 
perpetual count and average cost is not an issue. 

Assuming inventory is appropriate for the client, the quickest way to get an overview of the extent 
of the situation is to compare the inventory valuation summary report to the Balance Sheet 
inventory asset balance as of the same date.  The detail on the report itself such as negative 
inventory balances or average cost amounts that do not look reasonable provide some key 
indicators, a difference between the Asset Value total on the report and the inventory asset 
balance in the general ledger is another tell tale sign that some work will be needed in this area. 

As part of the reconciliation and cleanup process, it may be necessary to deal with additional 
issues such as correct procedures, what is the unit of measure, and how use tax, samples, etc. 
are being recorded. 
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INVENTORY FIXES 

ITEMS OVERVIEW 
An item is anything that a business will sell. The easiest way to think about an item is to 
understand that it is the link between the information entered into a form and the transaction that 
is recorded to the various accounts in the general ledger. Any line that will have a corresponding 
dollar amount with it will require an item. The list can be as simple or as complicated as you 
choose. For example, if the business sells pizzas, one item is all that is required. As each invoice 
is created, the description and price could be revised as needed. The other alternative would be 
to create items for each of the different kinds of pizzas sold. This approach would eliminate the 
need for revisions as the invoice is created since the description and price would come up 
automatically. More sophisticated sales reports would also be possible in the latter example. 

There are many judgment calls and different ways to achieve accurate general ledger results.  
Review of the item list is critical to A) confirm that the items have been set up correctly and B) 
that the decisions made are appropriate for the business based on the flow of paperwork, 
accounting knowledge, QuickBooks experience, etc. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Lists > Item List 

 

Item Types 
When creating an item list, there are several choices of item type to choose from. The type is 
important for subtotals on reports and for some function options. 
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Below is a list of the types and the typical use for each: 

• Service - most commonly used for items such as labor, consulting, hourly fees, etc.  This 
type of item is required for use on timesheets. 

• Inventory part - items that are normally carried in stock until sold. This item type will keep 
a running balance of quantity on hand and moving average cost. This item type will 
record purchases into an Other Current Asset account when purchased and reclassify 
the appropriate amount to cost of goods sold when an invoice or cash sale receipt is 
created. Detailed discussion of this type of item is beyond the scope of these materials. 

• Inventory assembly - items that are created from other inventory items (i.e., assembled) 
then carried in stock until sold.  This is a new item type with version 2003 and above, 
Premier only.  This item type will keep a running balance of quantity on hand and moving 
average cost. This item type will record purchases into an Other Current Asset account 
when purchased and reclassify the appropriate amount to cost of goods sold when an 
invoice or cash sale receipt is created. Detailed discussion of this type of item is beyond 
the scope of these materials. 

• Non-inventory part - items that are not kept in stock.  This could include items such as 
custom or special orders. This item type is also used if the average cost method of 
valuing inventory is unacceptable or perpetual inventory counts are not necessary. As 
items are purchased, they are simply expensed. 

• Other charge - freight, gift-wrapping services, expenses that are passed through to the 
customer are all examples of other charge type items.  If an “opening bal” item is to be 
created for entering the beginning balances for a new set up for Accounts Receivable 
and Accounts Payable, this is usually the type that is used. 

• Subtotal - a special item type that permits a subtotal line on an invoice to accumulate the 
amount due of all lines entered previously. 

• Group - this item type is used when several items are sold at the same time. There is the 
flexibility of printing all of the individual components on the customer’s copy of the 
invoice, or showing the detail only on the screen with one line on the printed copy of the 
invoice that merges the detail together.  The primary drawback to this item is, although 
inventory and any other items are correctly reflected as a group is sold, there is not a way 
to run reports on the group itself.  For example, if an installed door set is sold that 
includes a door, the hardware, and labor, a sales report will show the appropriate amount 
of revenue for each component but will not show how much revenue was generated from 
the sale of the door set group, only how many doors were sold, installed or not. 

• Discount - this is a reduction on the invoice that can be either a flat dollar amount or a 
percentage of the line immediately preceding it. If a discount is to be given off of each 
item, the discount will be entered either after each item, or once after a subtotal of all 
items.  

• Payment - if a payment is received at the time of the invoice, this is item type to be used.  
Keep in mind, however, that a statement shows only the totals from transactions, i.e., the 
invoice on the statement will show the net amount due on the statement after the sale 
and payment have both been entered.  If it is important to show the payment on the 
statement, entering an invoice then creating a receive payment transaction may be 
preferred. 

• Sales Tax - based on the customer being taxable, and the item being taxable, this item 
will calculate the tax liability due based on the tax percentage entered. 
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• Sales Tax Group - in California, it is the recommendation of this author that the sales tax 
for each county be each created as a unique sales tax item, rather than entering the 
individual jurisdictions and grouping them together. The resulting sales tax liability report 
will be easier to reconcile using this method. 

Inventory versus Non-inventory type parts 
Inventory in QuickBooks is based on average cost. If this is an acceptable method for the 
business, QuickBooks works well when set up correctly and proper procedures are followed 
consistently for buying, selling and adjusting the inventory item balances. With that being said, 
when are inventory type items appropriate and when are non-inventory type items a better 
alternative? 

Let us start with the definition of inventory parts versus non-inventory parts.  

With inventory, the same item is coded to an asset, a cost of goods sold, and an income type 
account. As the items are purchased (on the items tab of a bill, check, credit card charge, etc) the 
inventory balance is increased for the quantity and cost of the item on the balance sheet.  

Non-inventory parts, however, only have one account and both the purchases and sales are 
recorded to the one account. To modify this, it is possible to edit the item and check the box in the 
middle of the item (Pro and higher only) to use the advanced job costing features. What the box 
says on the item is not important, what is important is that by checking the box the item now has 
"two sides:" One account for purchases and one for sales. With non-inventory type parts, the 
purchase is expensed and the sale is recorded as income. There is no matching of the timing 
between the two. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Lists > Item List > Item (at the bottom of the 
list) > New Item 
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Items can be changed for coding corrections, or to change a non-inventory part to inventory. 
There is not any way to change the items from inventory to non-inventory (short of starting a new 
file or making the inventory items inactive). Make any changes carefully, because it is possible 
that depending on what you all the history could change as well.  

The most important aspect of using inventory is to always buy it before you sell it. And do not 
ignore warning messages that state that you do not have enough in inventory to sell. This 
message is indicative of the way you are using inventory in QuickBooks. 

INVENTORY PURCHASES VERSUS SALES 
By virtue of being a perpetual inventory system proper procedures are critical.  One of these is 
using the same item for purchases (i.e., bills, checks, item receipts) as well as for sales (i.e., 
invoices, cash sales receipts).  The quickest way to confirm the item is used when buying the 
product as well as when the product is sold is to do a quick report. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Lists > Item List > Reports  
(at bottom of the list) > QuickReport 

 

76 



Top 10 QuickBooks Mistakes Clients Make 

ITEM RECEIPTS 
If an item has been received, but the bill has not arrived, create an item receipt.  An item receipt 
will not age in Accounts Payable until the form is edited to confirm that the bill has been received 
(i.e., it does not show on the pay bills window).  The item receipt will increase the Inventory and 
Accounts Payable balances.  This information can be linked to a purchase order either when the 
vendor name is entered, or from the Select PO button at the bottom of the items tab.   

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Vendors > Receive Items (with or without a 
bill – use checkbox to indicate) 

 

If no Purchase Order exists, simply enter the information manually on the item tab of the form. 

TIP: When the bill is received, click on the box in the upper right hand corner and the terms and due 
date fields will appear. This will activate proper aging and permit bill payment procedures.  This step 
is important, if a new bill is entered rather than the item receipt being edited, the Inventory and 
Accounts Payable balances will be inflated. 
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ADJUST QUANTITY/VALUE ON HAND 
Once the actual count has been completed, the inventory quantities can be adjusted through 
QuickBooks by using the adjust qty/value on hand option.  Keep in mind the ending count is being 
entered as of the date at the top of the screen and the software will compute the difference with 
the value adjustment based on the average cost of the item.  That average cost is calculated 
based on the running average cost from any prior adjustments to the value and any actual 
purchases of the items. If the items do not have an average cost, the cost entered in the item set 
up will be used.  If no cost was entered when the item was set up, the cost adjustment will be 
zero.  If an adjustment needs to be made to the value, check the value adjustment box to enter 
the total value of the item based on the quantity of the items on hand (i.e., enter the total for the 
item, not the cost of each item). 

TIP: The standard form appears to change the quantity.  If the value needs to be adjusted as well, 
click on the value adjustment box to the bottom left of the screen to view current value and new value.   

NOTE: that the new quantity and value should be for the entire extended total for the item (not each). 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Vendors > Inventory Activities > Adjust 
Quantity/Value on Hand > Value Adjustment 
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CREDIT CARD USE ERRORS 

ERRORS & SYMPTOMS 
• Common Errors: 

o Only the amount to be paid is entered into QuickBooks with some type of 
“guesstimate” of how the payment should be allocated 

o Accounts Payable features used to enter bills for revolving debt balances 

o Balance is a single entry in expense account 

o Credit card balances not recorded in QuickBooks at all 

• Primary Indication: Financial Statements are significantly suspect due to missing or 
misclassified spending 

First there is the confusion of the term credit card: are you accepting credit cards as a form of 
payment or are you using a credit card to pay someone else.  Then there is the discussion on 
how the information should be entered into QuickBooks properly.   

If the business carries a credit card revolving balance, even occasionally, then the easiest 
method of tracking the amount due is using a credit card type account. 

If the business uses a credit card but pays the balance in full each month like any other vendor, 
using the Accounts Payable feature to enter a bill each month when the statement arrives is 
probably acceptable.  The transactions can be split on the expense and item tab of the bill to 
reflect accurately in the general ledger.  The only potential problem with this method is any timing 
differences based on the date of the bill versus the date of the transactions. 

A common error is that only the amount to be paid is entered into QuickBooks with some type of 
“guesstimate” of how the payment should be allocated.  Or to eliminate guessing and the time 
consuming process of actually entering the detail of the charges incurred on the credit card one 
expense account is used for all credit card charges.  Both of these errors create significant 
distortion of the financial statements due to missing or misclassified expenditures. 
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CREDIT CARD USE FIXES 

USING BUSINESS CREDIT CARDS OVERVIEW 
Revolving debt is a way of life for many small businesses.  This additional leverage permits 
growth that would not otherwise be possible.  Keeping track of the balances and related charges 
can be a challenge.   

CREDIT CARD TYPE ACCOUNT 
Although QuickBooks has Accounts Payable features that could be used, typically using the 
feature specifically designed for entering and reconciling credit card charges from paying for 
goods and services is much more efficient.  The reasons include: 

• A reconciliation process that includes balancing QuickBooks to the statement from the 
credit card company and automatically generating a check or bill to pay all or a portion of 
amount due. 

• Accounts Payable Aging Reports and due dates are distorted when the entire balance is 
not paid in full. 

• Credit card charges are typically deductible for income tax purposes whether the credit 
card company has been paid or not.  When creating reports on the cash basis Accounts 
Payable transactions coded to Profit and Loss accounts will automatically reverse. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Lists > Chart of Accounts > highlight the 
credit card account 
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CREDIT CARD TRANSACTION ENTRY - ONE ENTRY OR MANY? 
The first step in using the credit card feature is to enter the charges and credits as the credit card 
is used to pay for the purchase of goods and services. 

Entering the charges as the credit card is used will eliminate the need to do it when the statement 
comes each month, plus recording the transactions throughout the month will result in more 
accurate interim financial information. In many situations, for a variety of reasons, this is not 
practical for some businesses.  

There are other alternatives. You could: 

• Enter one charge for the month for the total amount purchased using the credit card and 
manually reconcile the receipts to the statement. The detail lines can be entered as splits 
so the general ledger remains accurate; or 

• Enter one charge for the month for the total amount purchased and code it to a credit 
card clearing account that will be reclassified based on the receipts. This method can be 
more cumbersome; or 

• Enter the detail transactions individually when the statement arrives and any transactions 
without a receipt are noted as such in the memo field (so a report can be generated and 
cleared as receipts are obtained) or coded to a credit card clearing account pending 
reconciliation with the receipts. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Home Page > Enter Credit Card Charges 
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The most important issue with any of these methods is that the procedures are documented and 
followed exactly each time. This will eliminate reconciliation nightmares in the future. It is also 
important as documentation when receipts are difficult to obtain.  

NOTE: Many credit card companies also have the credit card statements available in a 
downloadable format that may be able to be imported into QuickBooks.  In fact QuickBooks even 
has its own downloadable credit card that clients can apply for.  Choose Banking > Online 
Banking Services > QuickBooks Credit Card or call 1-800-900-6708 for more information. 

CREDIT CARD RECONCILIATION 
When the statement arrives, it should be reconciled.  This process is very similar to the bank 
account reconciliation process. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Home Page > Reconcile > Choose credit 
card you are reconciling  

 

The main difference between reconciling a checking account and reconciling a credit card 
account is that at the end of the reconciliation process when the “Reconcile Now” button has 
been clicked, a screen will appear to provide an alternative to enter a check to pay the credit card 
now or a bill to pay the credit card later.  Either choice is acceptable.  The most important 
decision to make is the amount that will be paid.  By default the amount is to pay the balance in 
full.  The amount should be overridden based on what will be paid to permit reconciliation with the 
next statement. If this amount changes prior to the check printing process, the bill or check should 
be changed to reflect the actual payment. 
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EXTRA PAYMENTS 
Making extra payments is an excellent way for businesses to reduce expensive revolving credit 
card debt.  With the ease of online payments for most cards, and the fact that even a few days of 
less interest can result in notable savings, many business have begun using this as a profit 
increasing strategy. 

For example, an outstanding balance of $10,000 at 15.99% interest is $133.25/month.  Making 
the minimum payment (typically 2%) of $200 barely covers the interest charge.  The small 
amount that goes to reduce the debt will only result in about $1 reduction in the next month’s 
interest charge.  However, making the minimum on the due date, and paying an additional 
payment will make a significant difference in reducing the principal balance of the debt and 
therefore reducing the interest charges that continue to accrue. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Home Page > Write Checks 

 

Since the check or bill will not be created as part of the reconciliation process, it will be necessary 
to manually enter it.  The trick to entering the transaction correctly is to code the payment on the 
expense tab to the credit card type (liability GL) account.  This will reduce the credit card liability 
and record the payment for the next reconciliation. 
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MOST IMPORTANT FIX OF ALL! 

Train your clients to use QuickBooks properly  
to eliminate these errors in the future. 
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APPENDIX A 
INVENTORY OVERVIEW 

According to GAAP, inventory (i.e., personal tangible property) can be defined in one of three 
ways:   

1. Held for sale in the ordinary course of business; 

2. In the process of production for sale; or 

3. Consumed in the production of goods or services to be available for sale.   

For the latter two options, managing inventory within QuickBooks is not an appropriate solution.  
For manufacturing, work in process, and/or consumables, another inventory management 
software package should be explored.  You can still use QuickBooks for the rest of the 
accounting and just journal in the inventory changes on a daily or monthly basis. You may also 
find a solution that works in conjunction with QuickBooks from one of the many Intuit developers. 
For more information, go to: accountant.intuit.com 

QuickBooks does work well when inventory is purchased and then sold without changes to it.  
The only exception may be light manufacturing that simply groups items together for sale without 
the need to add labor or other burden amounts into inventory.  New with Premier Version 2003 is 
the added type of inventory assembly. 

After determining that the type of inventory matches the capabilities of QuickBooks, the next 
factor to be addressed is the basis that the inventory will have on the Balance Sheet.  Inventory is 
a Current Asset type of account, which is set up as part of the chart of accounts in QuickBooks.  
The inventory, according to GAAP, should be recorded at cost, which includes all direct and 
indirect costs incurred to prepare it for sale.  Inventory is being purchased and then immediately 
being sold, therefore, this is usually not an issue.  Assuming that as the inventory is purchased all 
costs are included (i.e., any packaging, freight, etc.) in the amount recorded in QuickBooks for 
each item.  There are several exceptions to this general rule, such as including indirect costs, the 
lower of cost or market, certain conditions that may make an amount in excess of cost 
acceptable, etc.  Those alternatives are beyond the scope of these materials.  Assuming that the 
cost will be the basis for valuing the inventory, the next decision is which method will be used.   

Average Cost 
The method of inventory valuation to be used for GAAP should be the one that most accurately 
matches the cost of goods sold with the related sales. QuickBooks uses a perpetual inventory 
system with a moving average cost.  After each purchase or sale, a new average cost is 
computed, as opposed to the calculation at the end of the period (periodic inventory system).  As 
an item is sold, the average cost at that point is used for the amount to be charged to cost of 
goods sold.  According to GAAP this is an approved method; however, it is not the best method 
for all business entities.  If average cost is an appropriate method, and the inventory procedures 
are applied consistently (i.e., a purchase of the item is recorded prior to sale, and subsequent 
purchases and sales are recorded in the order they occurred), no additional adjustments may be 
needed prior to issuing the financial statements.  There are several reports that will aid in the 
preparation of work papers and in performing analytical procedures.   If another method is to be 
used, such as first-in, first-out or last-in, first-out, there is not an automated solution from 
QuickBooks but a manual valuation adjustment can be entered. The same is true if the business 
is required to capitalize warehousing costs. 
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QuickBooks has an inventory feature that will track the quantity on hand for inventory parts in the 
item list.  Once the items have been set up, QuickBooks will do the following: 

• Assist in completing ordering information on purchase orders for vendors 

• For Premier Version 2003 and higher permit building assembly units 

• Assist in completing sales information on sales receipts and invoices for customers 

• Record sales and cost of goods sold in the general ledger as items are sold 

• Compute the value of the inventory balance as items are received and sold 

• Show the average cost by item 

• Warn when a sale is being created for a higher quantity that what is calculated to be on 
hand 

QuickBooks inventory is a powerful tool which, when used correctly, can provide valuable 
financial and management information to the business owner and Accountant.  Some examples 
include:  

• trends in items sold to better manage inventory levels 

• sales detail to analyze items needed for seasonal fluctuations 

• gross profit results to determine which items should be expanded, decreased, or require 
price changes 

• inventory valuation to determine if the levels of inventory on hand are reasonable 

• more accurate financial results for management and planning purposes 
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APPENDIX B 
JOURNAL ENTRIES OVERVIEW 

In traditional accounting, the journal entry is a record of a transaction in which the total amount in 
the Debit column equals the total amount in the Credit column, and each amount is assigned to 
an account on the chart of accounts. For the day-to-day transaction entry, QuickBooks uses 
familiar forms (invoices, bills, checks, etc.) and the back-end journal entries are created 
automatically. When you enter a transaction directly into a non-bank balance sheet account 
register, QuickBooks automatically labels the transaction GENJRNL in the register and General 
Journal on reports that list transactions. 

In traditional accounting systems you must perform various closing procedures. QuickBooks 
automates this process by automatically transferring net income into the Retained Earning 
account at the beginning of a new fiscal year when Balance Sheet reports are created.  You 
cannot view a journal entry to see this process, it occurs automatically.   

TIP: If the net profit or loss each year should be “closed” into an account other than Retained 
Earnings, there are two ways to handle this issue.  One is to change the name of the account (i.e., for 
a sole proprietorship change the name of Retained Earnings to Owner’s Equity).  The second 
alternative is to create a journal entry to reclassify the amount correctly (i.e., reclassify retained 
earnings to various partner accounts).  To protect the integrity of the data for the future, use the 
password protection feature of closing dates as described in an earlier chapter. 

On the company pull down menu you can choose to make manual journal entries.  In traditional 
accounting systems, to “post” is to transfer data from the book of original entry to a ledger. In 
QuickBooks, the original entry is on a form (invoice, bill, check, and so on), and the equivalent of 
a ledger is a report. QuickBooks handles all posting automatically and immediately when you 
record the form.  

QuickBooks also allows you to correct mistakes by editing and recording the original form again 
at any time. To protect previous records from accidental change, use a QuickBooks password 
and closing date. 

Entries for depreciation, tax provisions, etc. must be made in the more traditional fashion. For 
clients using job costing reports, there are several places which do not permit you to assign a 
customer to the amounts, so a journal entry is required to reclassify the amount within the same 
account from no name (i.e., blank) customer to the correct customer: job. 

With many traditional software packages, any adjustments are handled through journal entries in 
the general ledger.  In QuickBooks, however, the creation of journal entries, and their impact on 
the financial statements, may not achieve the desired results, and are better handled through the 
use of the appropriate form or transaction entry page. 
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QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Company > Make Journal Entries 

 

Each transaction is recorded in the general ledger via journal entries.  It is possible to create a 
report that presents the details for each transaction.  This report, by default, in QuickBooks 
Premier Version 2003 includes the feature of collapsing the detail lines for the same account into 
one line.  This is indicated by the notation of “multiple“in the memo column.  To see the individual 
detail lines, click on the expand button at the top of the report.  This report can also be filtered for 
a specific transaction type (for example, journal), by date entered/modified, by a specific memo, 
etc. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Reports > Accountant & Taxes > Journal 
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JOURNAL ENTRY RULES 
Typical journal entries for QuickBooks include booking depreciation entries, income tax 
provisions, and loan interest adjustments.  If it has been determined that a journal entry is in fact 
needed, keep in mind the following rules: 

• Only one Accounts Receivable or Accounts Payable type account per entry. 

• Any entry to an Accounts Receivable or Accounts Payable type account will require a 
customer or vendor, respectively. 

• If QuickBooks is used as a write up program and Accounts Receivable or Accounts 
Payable detail is provided from another system, it is usually more efficient to create the 
accounts using the other current asset or other current liability type accounts. 

• All journal entries may be considered to be cash basis, regardless of the accounts 
affected based on where the Accounts Receivable and Accounts Payable accounts are 
placed in the journal entry. 

• Journal entries should not be made to inventory or payroll accounts.  To do so may 
create subsidiary reports that do not agree with the general ledger. 

• Entries can be made to correct class entries by choosing the same account for the debit 
and credit and only making the class designation different. This will re-allocate between 
classes, while leaving the GL account the same. 

• As each journal entry is saved, the general ledger is automatically updated. 

• To create a report of just the journal entries, filter the Transaction Detail by Account 
report or the Audit Trail report for the transaction type of journal.  If only the accountant 
journal entries are to be printed, choose the entered/modified date from the point that the 
financial statement reconciliation work began to the current date. 

 

Adjusting Entry Progress: 

New with version 2002 is the ability to turn on the preference to automatically number journal 
entries. 

New with version 2003 are several additional journal entry options that include a feature to 
reverse a journal entry, to view a list of journal entries on the bottom of the screen while entering 
a journal entry, etc. 

New with version 2004 is the ability to make an entry as an adjusting entry and then create an 
adjusting trial balance report. 

New with version 2008 is the ability to have the adjusting entries appears on a working trial 
balance report, as well as the ability to reverse an entry. 
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APPENDIX C   
FIXED ASSET LIST & FIXED ASSET MANAGER 

FIXED ASSET LIST 
This feature was new with version 2004 for Pro and higher products (the Basic product only 
permits viewing and editing fixed asset items, not creating new ones).  The purpose is for 
capturing the details of the asset in a way that was not available previously.  These fixed asset 
items can then also be used on purchase and sales forms (although this use will probably be 
quite rare).  The most significant reason for this new list is for the integration with the Fixed Asset 
Manager available with QuickBooks: Premier Accountant Edition or the Enterprise Solution.  This 
will streamline the process for the accountant because the information will already be entered into 
QuickBooks with the details needed to accurately calculate book value and depreciation amounts.  

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Lists > Fixed Asset Item List > Item > New 

 

Asset Name/Number: designates how the fixed asset item will appear on the item listing on 
sales and purchase forms.  Keep in mind that this item will be included in with the item list.  
Consider, for example, adding a FA before the name or some other way to designate that it is 
from the Fixed Asset Item List. 

Asset Account: the general ledger account that will be used for purchase and sales 
transactions. 

Purchase Information: the default information that will be used when this item is purchased.  
Enter the description, new or used (important for the depreciation calculation), date, cost, and 
vendor for when the asset was purchased. 
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Sales Information: Once the check box is marked that the item has been sold, the additional 
fields become available to enter the sales date, sales price, and sales expense.  

Asset Information: The additional fields here permit the asset description, location, PO number, 
and Serial number, a date for the expiration of the warranty and a field for notes. 

NOTE: Until this item is actually used on a purchase or sale transaction, the general ledger does not 
reflect the acquisition or sale of the asset. 

TIP: The Fixed Asset list can integrate with the Fixed Asset Manager that is included in the 
QuickBooks: Premier Accountant Edition product to calculate depreciation. 

NOTE: On the list itself, the FAM Number is the number that the Fixed Asset Manager uses for 
tracking this asset if the Accountant uses it to calculate the depreciation. 

TIP: It is also possible to create a new item as you are entering a transaction by using the item field.  
If the fixed asset type item has not been set up, it will appear as a choice when set up is chosen. 

FIXED ASSET ENTRY 
To record the transaction correctly, obtain the bill of sale or other paperwork that supports the 
purchase.  This paperwork should detail any additional costs that should be capitalized (such as 
delivery and/or installation), as well as any amounts that can be expensed in the current period 
(for example the license fee for a vehicle purchase).   

Prior to making the entry, it is also important to discover what has been recorded in QuickBooks: 
was there a down payment, if so, how was it recorded; have there been loan payments made 
already, how were they recorded; has the fixed asset and/or loan accounts been created on the 
chart of accounts, if so, was any activity already entered onto the register?   

Once the determination has been made as to what was recorded, it is simply a matter of creating 
a journal entry to reclassify everything correctly. 
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FIXED ASSET MANAGER 
This tool is an integrated application available in QuickBooks: Premier Accountant Edition and 
Enterprise Solution Products.  This integrated product adds another option to the Accountant pull 
down menu and will automatically launch the program from within QuickBooks.  The fixed asset 
list is then used to determine depreciation which can post a journal entry back to QuickBooks 
automatically. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Accountant > Manage Fixed Asset >  
Apply Query Criteria 

 

The features include: 

• Tight integration with QuickBooks Data  

• A detailed, customizable asset entry screen  

• Six depreciation bases (Book, State, Federal, Other, AMT, ACE)  

• Projected depreciation calculations  

• Disposition tracking  

• Custom queries and sorting  

• Full calculation overrides  

• A wide variety of built in depreciation reports and forms  

• Multiple ways to export and import data  

• Integration with ProSeries tax products  
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APPENDIX D 
LOAN MANAGER 

In prior versions of QuickBooks, creating amortization schedules required Excel or some other 
product to calculate loan repayment schedules.  New with version 2004, a loan manager is built in 
with the Pro and higher products. 

To use this integrated product, first obtain all loan-related information.  The actual loan document 
is preferred, but at a minimum the liability account will need to be set up on the chart of accounts, 
origination date, the loan amount, payment amount, interest rate, term of loan, payee, loan 
number, etc.  Next, choose Banking > Loan Manager. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Banking > Loan Manager 

 

ADD A LOAN   
• The Account Name is available from the other current liability and long term liability type 

accounts.   

• The lender is available from the vendor or other names list.   

• The origination date is the date the loan was funded.   

• The original amount is the amount that was borrowed when the loan was obtained.  
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• The terms should be entered as a number of months (for example, a 5 year loan is 60 
months).  It is important that all this information is entered accurately to ensure an 
accurate schedule of principal and interest payments. 

TIP: Be sure that both the account name and lender name are set up on the appropriate list prior to 
opening the loan manager.  If the loan manager is already open and then the names are added, the 
pull down lists within the loan manager will not be updated. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Banking > Loan Manager > Add a Loan 

 

Enter the required information, and then click the next button to proceed to the payment screen.   

On this screen, the date of the next payment is entered; the amount of the payment; payment 
frequency, and the loan payment number that is optional.  If the loan also has an escrow 
payment, it can be entered on this screen too.  By default the check box is marked to show a 
reminder 10 days before the payment will be due. 
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QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Banking > Loan Manager >  
Add a Loan > Next 

 

The next screen is the interest information. 

The interest rate is entered as a percentage.  The compounding choices are either monthly or 
based on the actual days.  If the latter is chosen it is possible to designate 365/365 for the period 
or 365/360.  The payment account is chosen from the bank accounts.  On this screen enter the 
interest expense account and the fees/charges expense account from the chart of accounts. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Banking > Loan Manager >  
Add a Loan > Next > Next 

 

Once everything has been entered, click the finish button. 
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Once the loan is set up, clicking on the payment schedule will display the principal and interest 
portions of each payment of the loan.   

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Banking > Loan Manager > Payment 
Schedule 

 

With the loan manager open it is possible to have the software enter a check or bill for the 
payment.  It is also possible to enter a regular payment or an extra payment.  The principal and 
interest amounts are filled in based on the payment schedule, but can be overridden as needed. 
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QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Banking > Loan Manager > Set Up Payment 
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The “what if scenario” button will permit evaluating the loan based on the following choices: 

1. What if I change the payment amount?  

2. What if I change my interest rate?  

3. How much will I pay with a new loan?  

4. What if I refinance my loan?  

5. Evaluate two new loans.  

Enter the new information and click on calculate to see the results. 

QUICKBOOKS: PREMIER ACCOUNTANT EDITION 2008: Banking > Loan Manager > What if Scenario 
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NOTES:  
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